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Abstract

KAddressBook is the KDE address book.
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Chapter 1

Introduction

KAddressBook is the main address book application for KDE; it enables you to
manage your contacts efficiently and comfortably. Since it is based on the kabc
library it supports resources, which can be used to load and save your contacts
to many different locations — not just the local file system, but also to LDAP
servers and SQL databases.

The user interface is similar to MS Outlook and it supports different views for
to represent the contact data differently; it also provides an incremental search
over all fields and a jump button bar to quickly access single entries. Since the
underlying kabc library uses the vCard format (specified in RFC 2426) as its
default storage medium, KAddressBook mainly reflects the supported entry
fields in its graphical user interface.
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Chapter 2

Using KAddressBook

2.1 Getting Started

After you have started KAddressBook (either using the panel menu or by typ-
ing kaddressbook at the command prompt) the KAddressBook main window
will be displayed:

— X
Eile Edit View Tools Settings Help
A4 32 & Kiled 4 i) X
Search: [Tobi | All Fields ® | Filter: | None 3|
Family Name | Given Name EBir‘thday |
FHOgUwsKl LuLL Tobias
Sanders Don hrd .
Schumacher Cornelius -&_.’ KOHIQ
Thorsen Bo —  KAddressBook
Zimmer Karl-Heinz Maintainer
Maolkentin Daniel 1982-05-21 KDE
Kanig Tobias 1982-07-19
LGppken Sven 1983-12-19

The KAddressBook main window.

2.2 Configure Resources

KAddressBook can use multiple resources for loading and storing its contacts.
After starting KAddressBook for the first time you will have a default resource
installed that saves all contacts in a vCard file under SHOME/ .kde/share/apps/kabc/std.vcf;
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you can add more resources by using the Resource Configuration dialog, which
is available in kcontrol under KDE Components->KDE Resources Configura-

tion:

¥ " KDEResources Configuration [modified] - Control Center

FEile View Settings Help

Index | Search Help

+- | Appearance & Themes
+- Desktop

+- @& Internet & Network

2.2 KDE Components

-3 Component Chooser

- File Associations

-4 File Manager

- 4 KDE Performance
KDE Resources Configuratic
Service Manager
Session Manager

-4 Spell Checker

-3 Peripherals

-\#» Power Control

-Ea Regional & Accessibility

L Security & Privacy

-& Sound &Multimedia

-y System Administration

-~ YaST2 modules

[T |

*
+
+
b
¥
+
+

-

[ei9]

Y ® B Lk
I D KDE Resources Configuration
—Resources

| contact ¥ |
Name |T|_.fpe | Standard Add...
F Kolab Server  kolab  Yes
F dirresource dir
B file-resource file
Bl imap-resource  imap
1 Idapkio-resource Idapkio

(L ==Eesalandard )
«| [ [[oim]

[ Apply || Reset |

The Resource Configuration Dialog.

Load the configuration module you want to add your resource(s) to. By select-
ing it from the combo box at the top of the Resources section. The module for

KAddressBook being contact.

Launch the Resource Configuration dialog by pushing the Add... button. Choose
the resource you want to add to your contact module and click OK to confirm

your choice.

Directory each contact will be stored in its own file;

File all contacts will be stored in one file;

IMAP To be written

Kolab The contacts will be saved in the contact folder of your DIMAP account.

Kolab server specificities: The Kolab resource should never be configured
as Read Only. In case you have added several types of resources you need
to set your Kolab Server resource as your Standard resource.

LDAP all contacts will be stored on a LDAP server;

Network all contacts will be stored in one file, which can be located on a re-
mote server (for example, through HTTP, WebDAYV, FTP or Fish).
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SLOX To be written
XML-RPC To be written

After selecting the type of resource another dialog appears where you can con-
figure the resource-specific settings.

The File and Directory resource supports different formats for storing the con-
tacts:

vCard the contacts will be stored in the vCard format, as specified in RFC 2426;

binary the contacts will be stored in a binary format — this increases perfor-
mance during loading and saving, but it is not portable like the vCard
format.

KAddressBook needs a standard resource, where all contacts should be saved
if no other resource is specified; for this reason, after starting KAddressBook
the first time, there is already a resource available. If you want to use another
resource as the standard resource, use the Use as Standard button to select
it. You must have both read and write access to the new standard resource,
otherwise you won't be able to select it.

2.3 Managing Contacts

To create or edit contacts, KAddressBook offers a dialog where you can input
all the data that can be stored in a vCard.
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TH_=fx
General Details Misc
Hame ||
iy Mame... Tobias Koenig
{ J Work ||
Role: hdaintainer Mabila ¥ |
Organization: KDE
Formatted name: koenig, Tobias { EdiLEbonehlumbals. J
L Home ;J Email: |tukoe@kde.urg
@ 2 [ Edit Email Addresses... |
URL: |hﬂp:fﬁ;«ww.kaddresshnuk.urg
l Edlit Addresses.. | IM address: |
Categories | [Family,5chool Private ¥
q oK h Apply ]| Cancel |

The Contact Dialog.

2.3.1 Automatic Name Parsing

KAddressBook tries to provide an easy name input by automatic name pars-
ing; for this to work properly it is sometimes necessary to add custom name
prefixes, suffixes or inclusions in the configure dialog. Nevertheless, no algo-
rithm is perfect, so the name you enter may be parsed incorrectly; in this case,
you can disable the automatic name parsing in the name edit dialog, which is
available by clicking the Name... button in the contact dialog. If you wish to
disable the name parsing for all new contacts you can disable automatic name
parsing globally in the configure dialog.

2.3.2 Formatted Name

The formatted name of a contact is used by other programs to represent it.
KAddressBook offers three predefined types of formatted names:

SimpleName <given name> <family name>;



The KAddressBook Handbook

FullName <prefix> <given name> <additional name> <family name> <suf-
fix>;

ReverseName <family name>, <given name>.

If none of the above types fit your needs you can select the Custom name type,
where you can add your own formatted name — this configuration can be
done in the name edit dialog. To specify a default formatted name type for
new contacts, use the configure dialog.

2.3.3 Instant Messaging

The IM Address text box holds the preferred Instant Messaging Address for
this contact. To add, view and edit additional IM Addresses, click the Edit IM
Addresses... button. The Edit IM Addresses Dialog appears.

FProtocol Address Add. .

2IRC argonel on irc.eu.freenode net
¥ MSN Messenge argonel

Note: Please read the help page before adding or editing Instant
Messenging Addresses here.

Help Cancel

The Edit IM Addresses Dialog.

A contact can have multiple instant messaging addresses associated with it.
Other applications, such as Kopete and Konversation, store their information
here. It is recommended that you add, edit and delete instant messaging ad-
dresses in Kopete or Konversation rather than here, since they can assist you
better in adding the address, adding the user to a group, and so on. If you are
not interested in whether they are picked up in another application, and just
want to store the instant messaging address with the contact, then it is fine to
add and edit it here.

For more information on adding new Instant Messaging Addresses, see Kopete’s
handbook and Konversation’s handbook.

2.3.4 Crypto Settings tab

In this tab, you can define preferences with regards to cryptography for a con-
tact. At the time of this writing, only KMail will make use of these preferences


help:/kopete/getting-started.html#creating-accounts
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help:/konversation/linkaddressbook.html
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when composing messages. This mechanism replaces the barely editable per-
recipient crypto preferences of earlier KMail releases.

Allowed Protocols Here, you can restrict the cryptographic message formats
that can be used for this contact. See the section on Cryptographic Mes-
sage Formats in KMail’s handbook for a discussion of the different avail-
able formats.

Preferred OpenPGP encryption key, Preferred SSMIME encryption certificate
Here, you can assign a preferred OpenPGP key and/or S/MIME certifi-
cate to be used when encrypting to this contact. Otherwise, the local
keyring and local certificate box are searched for matching keys and cer-
tificates.

Message Preference Here, you can select from a set of directives for user in-
teraction both when signing and when encrypting.

<none> No preference, use whatever mode KMail defaults to.

Never Sign, Never Encrypt Never sign (encrypt) messages to this con-
tact. Don’t ask for confirmation (except in the case of conflicts with
preferences of other contacts).

Always Sign, Always Encrypt Always sign (encrypt) messages to the
contact. Don’t ask for confirmation (except in the case of conflicts
with preferences of other contacts).

Always Sign If Possible, Always Encrypt If Possible Always sign (en-
crypt) messages to this contact when it would be possible to do so.
Don't ask if it isn’t possible. Situations in which signing might not
be possible include other recipients having signing preferences of
"Never". Situations in which encryption might not be possible in-
clude missing keys/ certificates for this or other recievers.

Ask Always ask whether to sign (encrypt).

2.4 Using Views

In this version, KAddressBook offers different views, which can represent the
contacts in different ways:

Table View All contacts are listed in a table; they can be sorted by clicking at
the column header of the table. The columns of the table depend on the
fields which were selected in the view configuration dialog.

Icon View The contacts are listed as icons in a view. If the contact contains a
photo or logo, then it is used in the view; otherwise, an default icon is

used.

Card View All contacts are presented in form of cards. The titles of these cards
are the formatted names; the body of each card depends on what fields
were selected in the view configuration dialog.


file:/kmail/the-composer-window.html#cryptographic-message-formats
file:/kmail/the-composer-window.html#cryptographic-message-formats
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lv. o = B b
-E i Select Fields
Select Fields l all > J Selected fields:
? Additional Mames H Given Mame
Anniversary Family Mame
Default Filter Assistant's Mame E| Email &ddress
' sy Ll
- -l
ﬁ [a]8 F | Cancel )

The View Configuration Dialog.

The Selected Fields page offers you the possibility of selecting which of the

stored details of a contact should be shown in the view. In the Default Filter
page you can setup what filter should be used by the view.

2.5 Using Filters

You can setup filters in KAddressBook which depend on the categories a con-
tact belongs to. For example, you can create a filter that matches all contacts
which belong to the categories "Family” and "Friends’; you can also create a fil-
ter that matches all contacts which do not these categories. To manage filters,
use the filter configuration dialog;:
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Mame |

Categories

[ Business
O cCustamer
O Family
O Friend
O School

(=) Show only contacts matching the selected categories

) Show all contacts except those matching the selected categories

Cancel

The Filter Configuration Dialog.

Filters can be used in views to reduce the number of contacts shown. In the
view configuration dialog you can specify what filter should be used by a view

by default.

2.6 Using Extensions

Extensions are implemented as plugins in KAddressBook, so 3rd-party devel-
opers can provide more of them. At the moment we already have three exten-
sions:

Contact Editor Similar to the the contact editing dialog, but designed to allow
contacts to be edited quickly.

Location of Contact This extension takes the postal address of a contact and
loads a map service from the internet (like www.map24.de) with these
data; the result is shown in a HTML view.

Distribution List Manager This extension provides easy management of the
distribution lists: just create a new list and select a contact in the view;
then, after clicking Add contact, the selected contact is part of the distri-
bution list. A simpler way is to drag a contact from the view and drop it
over the distribution list manager. See Settings Menu about how to add
an extension.
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=
File Edit VMiew Tools Settings Help
R - ™ e % on,
A4 da & Klle~ gy 2
Search: |Tob| | All Fields | ® | Fitter: | None | *]
Family Name ‘ Given Name |Eir1.hday | |l|
M olkentin Daniel 1982-05-21 -" Tobias
Kanig Tobias 1982-07-19 - Kénig
— KAddressBook
l KAB-Developer I iJ l MNew List... J l Rename List... J l Remove List J Maintainer
KDE
Name ‘ Email | Use Preferred ‘
Schumacher, Cornelius schumacher@kde.org Yes .
Tobias Kénig tokoe@kde.org Yes Email tokos@kde.org
Homepage http:/fwww.
Add Contact l J l J kaddresshook.org

The main window with distribution list extension.
2.7 Import and Export

With the new import/export framework KAddressBook offers a dialog where
you can select which contacts are to be exported.

10
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Which contacts do you want to export?

—oelection:

(m) All contacts

) Selected contacts

() Contacts matching filter | TestFilter | & |

[0 Business
O Customer
[ Family
[ Friend
O School
() Category memhers

| Cancel |

The export selection dialog.

The following import and export plugins are available at the moment:

vCard the vCard format is standardized format (RFC 2426) that is supported
by most addressbook applications — KAddressBook can import and ex-
port versions 2.1 and 3.0;

Mobile Phone this plugin can import contacts from Nokia mobile phones via

11
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the gnokii library;

Eudora Addressbook with this plugin you can import your contacts from the
Eudora mail client;

CSV CSV (comma separated value) is a format that is used by many (address-
book) applications — you can import and export your contacts with this
format;

KDE2 to import your old addressbook data from KDE 2.X you can use this
item;

LDIF LDIF is a plain-text representation of LDAP data, used by Netscape and
Mozilla to store their addressbook data — KAddressBook supports im-
port and export of this format;

PAB PAB is the MS Exchange Personal Address Book format, used by MS Out-
look and MS Outlook Express to store their contact data — KAddress-
Book supports the import of this format;

Opera use this plugin to import the contact database of the Opera web browser;

Bookmarks this is a pseudo export plugin that makes the web URLs of your
contacts available in the bookmark menu of konqueror.

2.8 LDAP queries

Address information from LDAP servers can be imported into KAddressBook’s
local addressbook by using the LDAP search dialog.

To configure (a number of) LDAP servers, use the configuration dialog.

On the main toolbar in KAddressBook a button with a picture of a magnifying
glass over a book is available: use this button to open the LDAP search dialog.
The dialog itself is pretty straight forward; just type in parts of a name, email
address or phone number and press the Search button.

When the results display in the listbox it is possible to select one or more ad-
dress(es); you can then use the Add Selected to import the selected address(es)
to the local addressbook, or click the Send email to Contact to invoke a mail
program to write an email to the selected recipients.

The Recursive search checkbox is enabled by default; this will make the LDAP
query consider all objects below the base DN of each server. If you only want
to consider objects one level below the base uncheck this checkbox; if in doubt,
leave it checked.

12
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2.9 Preferences

You can modify many aspects of KAddressBook’s behavior in the preferences
dialog; the dialog can be opened via Settings — Configure KAddressBook or
using the toolbar icon.

O Contigire > KAddreseBooK S . B_l=
J Configure the address book

Address Book m

&
4 G |
K_ % eneral

LDA;Lookup ") Henor KDE single click
|®| Automatic name parsing for new addressees

— Script-Hooks

Phone: |am-phone -e %N‘

Fax: |

r Extension

Name EDescriptiun

Bl KAB Contact Merging Plugin Plugin for merging similar contacts

E KAB Distribution List Plugin Plugin for managing distribution lists

E KAB Location Plugin Plugin for displaying the location of a postal address

| Configure... J

Help Defaults q oK h Apply J 1 Cancel J

The preferences dialog.

29.1 The Address Book Page
29.1.1 The General Tab

Honor KDE single click If checked, KAddressBook pays attention to the KDE
single-click option.

Automatic Name Parsing for new addresses If checked, the automatic name
parsing feature is used for new addresses.

Script-Hooks Here you can specify the commands which are to be executed
whenever you click at a phone number or fax number link in the details
page.

Extensions In this list view you can enable and disable extensions individually
and configure their settings.

2.9.1.2 The Contact Tab

KAddressBook can automatically parse a name into its parts; to make sure this
works in many cases you can add, here, additional name parts, like prefixes,
suffixes and inclusions.

13
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Prefixes Here you can manage name prefixes, like 'Prof.” or ‘Dr.".

Inclusions Here you can manage name inclusions, like ‘van’ or "von’, which
are often part of Dutch or German names.

Suffixes Here you can manage name suffixes like ’Sr.” or Jr.”.
y g

Default Formatted Name Here you can select the default type of formatted
names to be used for new contacts.

2.9.2 The LDAP Lookup Page

On this page you can configure the LDAP servers that should be used for ldap
queries in KAddressBook.

Use Add Host... to add and setup a new server.

% AddHost-Konact IO

Host: |giruda~_.f.d'_.fndn5.nrg
Port: 389 =
Base DN: |dc=giroda',f, dc=dyndns, dc=org|
Bind DN: |
Passwaord: |
q QK F |_ Cancel J

The Add Host dialog - Example of LDAP Lookup configuration (Kolab).

You can include and exclude servers from the search by selecting or deselecting
their check boxes. In the server list. Press OK to close the dialog.

You may configure the search order by moving up or down the servers in the
list. This can be done using the corresponding arrows on the right side of the
dialog.

14
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Chapter 3

Command References

3.1 The File Menu

File — New Contact (Ctrl+N) Opens the contact editor for adding a new con-
tact.

File — Edit Contact Opens the contact editor for editing the currently-selected
contact.

File — Save (Ctrl+S) Saves the changed contacts.

File — Import Lists all available import modules.

File — Export Lists all available export modules.

File — Print (Ctrl+P) Prints the currently-selected contacts.

File — Send email to Contact Opens the preferred mail program with the currently-
selected contacts as recipients.

File — Send Contact Opens the preferred mail program with the currently-
selected contact details attached as vCard.

File — Quit (Ctrl+Q) Quits KAddressBook.

3.2 The Edit Menu

Edit — Undo (Ctrl+Z) Undos the last change.
Edit — Redo (Ctrl+Shift+Z) Redos the last change.

Edit — Cut (Ctrl+X) Cuts the currently-selected contacts.

15
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Edit — Copy (Ctrl+C) Copies the currently-selected contacts to the clipboard.

Edit — Paste (Ctrl+V) Paste the clipboard contents into the address book (if it
is in a valid format).

Edit — Delete Contact (Delete) Deletes the currently-selected contacts.
Edit — Select All (Ctrl+A) Selects all contacts.

Edit — Set Categories Opens a dialog where you can set the categories for the
currently-selected contacts; when the selected categories differ from the
categories of the contacts the dialog will ask you if you want to merge
these differences or if the categories should be overwritten .

Edit — Set Who Am I Marks the currently selected contact as the "Who Am I’
contact, which represents the user’s data. You should have such a con-
tact, because other applications, like KMail and KWord, can make use of
these data: this way you don’t have to input it separately in every appli-
cation .

3.3 The View Menu

View — Select View Lists all available views.

View — Add View Opens a dialog for creating a new view.

View — Modify View... Opens a dialog where you can modify the settings of
the current view.

View — Delete View Deletes the current view.

View — Refresh View Refreshes the current view.

3.4 The Tools Menu

This menu provides tools for acting on the contact database.

Tools — Lookup Addresses in Directory Opens the search dialog for addresses
located on LDAP servers. You can configure the server settings in the
configure dialog.

3.5 The Settings Menu

This menu provides options for configuring KAddressBook, changing its ap-
pearance, shortcuts and standard behavior.

16
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Settings — Toolbars Toggles the toolbars on/off.

Settings — Show Extension Bar Selects what extension should be shown in
the extension bar at the bottom of the main window.

Settings — Show Jump Bar Toggles the Jump Bar on/off.
Settings — Show Details Toggles the Details Page on/off.
Settings — Edit Filter Opens a dialog where you can edit the filters.

Settings — Configure Shortcuts... Opens a dialog for changing the key bind-
ings. Using this option you can change the standard keyboard shortcuts
for KAddressBook’s commands or create new ones.

Settings — Configure Toolbars... Opens a dialog for configuring the toolbar.

You can add and remove toolbuttons for KAddressBook’s commands
with this option.

Settings — Configure KAddressBook... Opens the preferences dialog.

3.6 The Help Menu

Help — KAddressBook Handbook (F1) Invokes the KDE Help system start-
ing at the KAddressBook help pages. (this document).

Help — What's This? (Shift+F1) Changes the mouse cursor to a combination
arrow and question mark. Clicking on items within KAddressBook will
open a help window (if one exists for the particular item) explaining the
item’s function.

Help — Report Bug... Opens the Bug report dialog where you can report a
bug or request a ‘wishlist’ feature.

Help — About KAddressBook This will display version and author informa-
tion.

Help — About KDE This displays the KDE version and other basic informa-
tion.

17
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Chapter 4

Command Line Options

KAddressBook supports some command-line arguments, which can be used
to influence its starting behavior:

kaddressbook —a, —-addr <email> Shows the contact editor with the given
email address.

kaddressbook ——uid <uid> Shows the contact editor with the given uid.
kaddressbook ——editor—only Launches in editor only mode.

kaddressbook ——new-contact Launches an editor for a new contact.

KAddressBook also supports all other command-line options common to KDE

and Qt™ programs; you can get a list of these options with --help, -~—help-k-
de, and --help-qt.

18
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Chapter 5

Options Without a User
Interface Representation

Apart from the options presented in the configuration dialog, some options can
only be set directly in the configuration file ((KDEHOME/share/config/kad-
dressbookrc) or through KIOSK.

ContactListAboveExtensions If enabled, extensions (e.g. the distribution list
editor) are shown below the contact list, not in an separate column. By
default, this option is disabled. To enable this option, add a line reading
(under [MainWindow] section):

ContactListAboveExtensions=true

19
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Chapter 6
Credits and License

KAddressBook - The KDE Address Book
Copyright (c) 1997-2003, The KDE-PIM Team

KAddressBook was originally written in 1997 by Don Sanders dsanders@kde.org.
Currently it is maintained by Tobias Koenig tokoe@kde.org.

This documentation is licensed under the terms of the GNU Free Documenta-
tion License.

20
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